
C hap te r 1

Inventor Face to Face

This chapter focuses on the Autodesk Inventor Suite’s 2009 inter-

face and the fundamental tools for accessing files, working with the tools of Inventor, 

and getting additional information.

One of the greatest barriers that I’ve found to learning new software (or learning any new 

task) is the feeling that you have no control over the environment you are working in. In this 

chapter we’ll look at ways to modify the look and feel of Inventor so that you feel more com-

fortable and learn where things are. A thorough understanding of the interface may not seem 

exciting, but getting comfortable with the interface and knowing where to look for help is the 

foundation for everything else that you will learn in this book.

Opening existing files■■

Understanding Inventor’s Interface behavior■■

Modifying the look and feel of Inventor■■

Managing file locations■■

Accessing the Help system■■
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2  ■   Chapter 1 : Inventor Face to Face

Learning to Use the Dialog Boxes
One thing that makes Inventor easy to use is a kind of “graphical language” common to 

all the dialog boxes. These are items that behave consistently wherever they appear. As 

you use Inventor, working with these items will become second nature. As you’re getting 

started, knowing what to look for will make it easy to understand what Inventor needs 

from you in order to accomplish your task.

Buttons
The following buttons and button states have the same effect no matter where you 

encounter them in Inventor’s interface:

A button with a red arrow indicates that Inventor needs you to select something. Text 

may appear next to the arrow, identifying the type of input that Inventor is looking for.

A button with a white arrow means that Inventor has been given the information that 

it needs.

The OK button will be grayed out until Inventor has the necessary user input to execute an 

operation. Clicking OK initiates the command or function and closes the dialog box.

The Apply button will also be grayed out until Inventor has the necessary user input to 

execute an operation. Clicking the Apply button initiates the command or function but 

it will not close the dialog box. This allows you to execute the function and start using it 

again immediately.

The Cancel button closes the dialog box without executing any operation.

The More button exposes additional options for a dialog box. Once those options 

become visible, the arrows then point to the left so you can hide the options again.

Any button with an ellipsis after the name launches another dialog box or selection 

window when clicked.

Tabs
Another element of the common graphical language 

is the way dialog boxes are organized. Many dialog 

boxes have tabs across the top, with each tab offering 

additional options. Though most common functions 

are contained on the first tab, when you begin work-

ing with a new dialog box, it is worth taking a few 

moments to explore what options are on the other 

tabs. For example, in the Extrude dialog box illus-

trated here, the Shape tab offers the basic options 

to select the shape and define the distance it will be 

extruded, while the More tab offers options to apply 

taper or draft to the shape.
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The Open Dialog Box  ■   3

Context Menus
You can access a large number of Inventor’s tools by clicking your secondary mouse button—

typically the right button—at different places on your screen. As in other Windows software, 

right-clicking displays a context menu of options that are relevant to what you’re doing at 

the time. For example, as you’ll learn in Chapter 5, right-clicking a drawing’s border in the 

Browser displays a menu that lets you delete the border or add a new one. In the exercises and 

examples in this book, I’ll often instruct you to right-click and select the next operation from 

a context menu.

The Open Dialog Box
Each time you start Inventor you will be presented with the Open dialog box (see Figure 1.1) 

to select the file(s) you want to work on.

Inventor LT users will see a slightly different Open dialog box. Inventor LT does not have assem-

bly capabilities, so there are elements that are not necessary to have. It will still be beneficial for the 

LT user to understand the capabilities of  Inventor Suite or Professional 2009 in case they use it in 

the future.

As in any contemporary software, this dialog box allows you to select a file or files to 

open in Inventor. If you’re accustomed to Microsoft Windows Explorer and some of its 

viewing options, this dialog box will seem familiar. Using it should be comfortable for 

you right away. There are several components to the dialog box, and it is important to 

understand what these parts are and what they will do for you.

Figure 1.1

File list displaying 
small icons

It is possible to resize the dialog box by clicking and dragging the corners in order to allow 

easy viewing of the information it displays.
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4  ■   Chapter 1 : Inventor Face to Face

Shortcuts and the File List
In the upper left of the dialog box is an area with a list of shortcuts to Frequently Used 

Subfolders (Figure 1.2). You can customize this pane to create shortcuts to folders that 

you’d like to access quickly. You can even set up subreferences and have a structure that 

replicates the folder structure on your hard drive.

Centered in the dialog box and making up the bulk of it is 

the File list, where the files are displayed. What files are listed is 

controlled by the File Of Type option, described shortly. You can 

open a file (or files) from here by selecting the filename(s) and 

clicking OK or by double-clicking on the filename.

At the top of the dialog box is the Look In field. This displays 

the name of the folder whose files are currently displayed below 

it in the File list. The arrow to the right allows you cascade the 

folder structure or to begin browsing for other folders.

Navigation Controls
To the right of the Look In field are four icons that allow you to navigate easily and to 

control how you view the files that you’re looking for. 

These tools share icons and functions with many standard Windows icons and tools. 

You will find commonality in the controls between Inventor and many Microsoft 

applications. This is done so that you don’t have to learn every aspect of the user interface 

from scratch.

Go To Last Folder Visited  ​The first button has an arrow pointing left. This button allows 

you to navigate back to the previous folder(s) you were browsing in. It works on the same 

principle as the Back button in a web browser. When you’ve just begun a session, the 

arrow will be grayed out, as you don’t have any browsing history to recall.

Up One Level  ​The next icon looks like a folder with a green arrow pointing up. This takes 

you up a level in your folder structure from wherever you are currently browsing.

Create New Folder  ​The third icon allows you to create a new folder in the folder that you 

are currently browsing in.

The View Menu  ​The icon on the right is a f lyout tool that allows you to change the way 

the files that you’re browsing will be displayed. Depending on the operating system you’re 

using, you will see different options ranging from a detailed listing of dates and file size 

to thumbnail previews of the files in the display area. In Figure 1.3 you can see the same 

folder as in Figure 1.1 being browsed with the Thumbnail display option.

Figure 1.2

Frequently Used 
Subfolders list
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The Open Dialog Box  ■   5

File Display Options
Immediately below the File list are three selection pull-down lists that control the file 

display options.

File Name  ​This pull-down displays the full 

name of the selected file(s). If you click 

the arrow to the right, it opens a list of 

recently open files.

Files Of Type  ​This option is very important. Clicking the arrow to the right lets you 

choose from a list of file types that Inventor can open. It’s important to filter the file 

types displayed because of the broad array of types.

Project File  ​This flyout allows you to select from a list of project files that have been used 

in the past. The active or current project file is shown any time the Open dialog box is 

brought up. To the right of the pull-down is a button marked Projects, which launches 

the Project File editor, which in turn allows you to select project files that have not been 

used previously, edit existing project files, or create a new project file. We’ll take a look at 

the Project File dialog box later in this chapter in the Project Files section.

To the left of File Display Options is the File Preview pane. As you select a file in the 

File list, a preview of that file appears in this area. Not all files have a preview to display.

At the lower left of the Open dialog box you’ll find three icons under the heading 

Quick Launch.

Figure 1.3

File list showing 
Thumbnail view
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6  ■   Chapter 1 : Inventor Face to Face

At least one of these icons will not be available at any given time. If you’re in the Open 

dialog box, the first icon will be available; it switches you from Open to the New dialog 

box. The middle icon switches you back to Open from New. The third icon is for opening 

files from the Vault, a great data management system that I highly recommend install-

ing. (The Vault comes with Inventor 

so there’s no additional cost but there 

are great benefits that I will talk about 

briefly in Appendix C.) This icon will 

be available only if the project file that is 

active has the Vault enabled.

In the lower right you’ll see the Find 

button. Clicking it displays a Find tool 

dialog box (Figure 1.4) that can execute 

simple or complex searches. You can 

search for file properties, creation dates, 

or strings of text, and you can even save 

your searches to be reused in the future.

Other Controls
Three more options complete the Open dialog box:

Options  ​Available only when you import, export, or open a file that can have additional set-

tings applied to it. For example, if you want to export a DWG file for use with AutoCAD, you 

can select which version of AutoCAD can open the file, back to AutoCAD 2000.

Open  ​Executes the opening of the selected file or files. You can open multiple files at the 

same time by holding the Ctrl key to select multiple individual files or by holding Shift to 

click a range of files. You can also open multiple files by dragging a file or files from Win-

dows Explorer onto the title bar of Autodesk Inventor.

Cancel  ​Exits the attempt to open a file and returns you to Inventor.

Opening a File
Now that you have had an overview of the parts and functions of the Open dialog box, 

let’s put what you’ve learned to use. (Some options will not be available to Inventor LT 

users; again, LT cannot work with assemblies.)

	 1.	 If the Samples project isn’t displayed as the active project, use the pull-down list to select it.  

It should be on the short Project File list. If it doesn’t appear on the list, open the Project File 

dialog box as described earlier, select Samples from the list, and click Open. This should set 

that project to be active and return you to the Open dialog box.

Figure 1.4

The Find tool  
dialog box
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The New File Dialog Box  ■   7

	 2.	 Use the Frequently Used Subfolders list to find the Assemblies\Engine MKII\Engine 

MKII.iam assembly file. Inventor LT users should select a part file of their choosing 

to review changes. You can find samples files to choose from at C:\Program Files\

Autodesk\Inventor LT Technology Preview\Samples.

	 3.	 Once you have found the file, you can select it with a single mouse click and click 

OK, or you can double-click on the file in the window. Once the file is open, you 

should see something like Figure 1.5.

The New File Dialog Box
The New File dialog box (Figure 1.6) is much simpler than the Open dialog box. Like the 

Open dialog box, it has a Quick Launch section that allows you to switch to the Open 

dialog box, and where you can set the active project file.

Every new drawing you create in Inventor is based on a template, which provides 

information such as borers, title blocks, layer colors, and the standard dimension style. 

These templates can be customized, and Inventor comes with a sizable selection to give 

you a head start. It is also possible to convert existing AutoCAD drawings to Inventor 

templates.

In the New File dialog box, Inventor’s collection of built-in templates is categorized in 

tabs across the top. There are templates for Default, English, and Metric measurements.

Figure 1.5

The Engine MkII 
assembly in the 
Design window
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8  ■   Chapter 1 : Inventor Face to Face

Navigating Inventor’s User Interface
With Inventor open and a file loaded, it is time to get familiar with the component of 

Inventor that you will use every time you start the program; the graphical user interface 

(GUI). Figure 1.7 shows the main components.

Figure 1.6

The New File dialog 
box showing Metric 

templates

Figure 1.7

The parts of the 
Inventor GUI

Title BarMenu BarPanel Bar Inventor Standard Toolbar

Browser Status Bar Design Window
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Navigating Inventor’s User Interface  ■   9

If you’re used to the look and feel of Microsoft Word (prior to 2007) and Microsoft 

Internet Explorer, you should find a lot of similarities to many of the standard tools in 

Inventor. If you are experienced with recent versions of AutoCAD, you will find a lot of 

similarities with the drawing and sketching tool icons in Inventor.

Across the top of the Inventor application is the title bar. It will remind you that you 

are in Autodesk Inventor and tell you what version you are using. It will also tell you 

the name of the file that you are currently editing if that file is in its maximized view. 

If the Inventor file is in a floating window, then each window’s title bar will display the 

filename.

Just below that is the menu bar, a collection of tools is organized in pull-down menus. 

These menus contain valuable tools for everything from an alternative way of opening 

files to measuring geometry on the screen. You can even launch a website containing com-

ponents manufactured by other Inventor users that you can download into your designs. 

The names, content, and number of these menus will vary depending on whether you 

have a file open and what type of file it is.

Over the course of the book we will examine some of the tools in the menu bar pull-

downs as needed. A majority of the tools in the menu bar establish how you are work-

ing with Inventor rather than containing the tools that you would use for modeling or 

drawing.

Immediately below the menu bar is the Inventor Standard toolbar. This is where a lot 

of the basic file and view manipulation tools can be accessed easily. The toolbar is a col-

lection of groups of different types of tools. The tools available depend on the type of file 

you’re editing at the time. Most of the differences will be found on the right end of the 

toolbar. The first three groups of tools are consistent regardless of the type of file you’re 

editing.

Since you have the assembly loaded, let’s use it to explore how you will interact with 

Inventor and take a closer look at some of the elements of the interface that we just 

touched on.

Let’s begin with an in-depth look at the Inventor Standard toolbar. Most of the other 

elements of the interface will be used as part of exercises, but the Standard toolbar con-

tains tools that are used to control and better understand the model that you’re creating. 

These tools do not create geometry, but they make it easy to do so.
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10  ■   Chapter 1 : Inventor Face to Face

On the left you may recognize the standard icons for New, Open, and Save. The third 

icon may not be immediately recognized; it is Open From Vault. This is the same tool 

that you saw in the overview of the Open dialog box.

The next section has to do with working in the context of parts and assemblies. The 

first two icons are our old friends Undo and Redo. If you make a mistake, Inventor will 

allow up to 30 steps of Undo and Redo. A great feature is that changes to the model view 

(zooming, panning, etc.) do not use Undo steps. You can even undo the creation or open-

ing of a file.

Immediately to the right of those tools is the selection Filters list. Filters are a tool for 

focusing or streamlining selections. They can limit or enhance the selection of certain 

types of entities in parts, assemblies, or drawings. The use of filters is a great thing to 

learn and explore. Many experienced Inventor users are missing out by not becoming 

more comfortable with them.

You will use the Return button frequently. This tool moves you from one editing state 

to the one above it. Its importance will become clear as we start working in Inventor.

Several toolbar buttons have a down arrow next to them. This indicates that an addi-

tional option or options are under the primary command. For example, the Sketch icon, 

which allows you to create or edit sketches, has a 3D Sketch button under it.

If Inventor is unsure that what it is displaying is the most current information, the 

Update button becomes available and allows you to update the data that is on the screen.

The third portion controls how you look at the file you are editing. Many of the icons 

will be familiar. They are commonly used tools, so take a moment to practice using them 

in context. Begin on the left and work your way across.

The first icon is Zoom All. No matter what your point of view, clicking this icon 

frames your model evenly in the Design window, which is where you are currently seeing 

the engine assembly.

Zoom Window allows you to zoom in on a specific area by creating a “window” frame 

around the area that you want larger. To create the frame, you select the tool, click where 

you want one corner, and while continuing to hold the button down, drag the size of the 

frame. When you’ve encompassed the area you want to make larger, release the mouse 

button. Figure 1.8 shows the zoom area being framed, and Figure 1.9 shows the result. 

Try enlarging your view of a portion of the assembly using the Zoom Window tool. You 

can also access Zoom Window by pressing the Z key on your keyboard.
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Navigating Inventor’s User Interface  ■   11

Click the Zoom icon. You’ll notice the onscreen pointer changes its shape to two 

arrows: a small arrow pointing up and a large arrow pointing down. Click and drag any-

where in the Design window, and note that as you drag up, the model gets smaller and, as 

Figure 1.8

Framing the area to 
zoom in on

Figure 1.9

The result of  
zooming
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12  ■   Chapter 1 : Inventor Face to Face

you drag down, the model gets larger. If you drag as far as you can in the Design window 

but want to continue to zoom, release the mouse button, move the cursor, and click to 

start zooming again. To stop the Zoom command, press your Esc key or right-click on 

the screen and select Done [Esc]. You can also access the Zoom command by pressing 

and holding the F3 key. Releasing the key ends the command. If you’re not convinced 

that it’s easy enough to access the Zoom command, there’s one more option. If you have a 

wheel mouse, try rolling it. If you roll the mouse away from you, the model gets smaller. 

If you roll the wheel toward you, it gets larger.

In AutoCAD you get the exact opposite zooming with a wheel mouse. This is because Auto-

CAD’s zoom is based on the idea of moving a camera and Inventor’s is based on moving the 

object that you’re looking at. If you absolutely need to have Inventor to zoom in the Auto-

CAD fashion, you can change a setting in the application options, which we’ll review later in 

this chapter.

Next try the Pan command. Panning is sliding the image on the plane of the screen 

without changing its size or the point of view that you have of it. As with Zoom, it is a 

click-and-drag tool. You can also release and restart panning while staying in the com-

mand. Pan is also available by pressing the F2 key or by pressing and holding the wheel  

or the middle mouse button.

The keyboard shortcut appears in brackets on the menu. For a complete listing of keyboard 

shortcuts, refer to Appendix A.

Zoom Selected centers and enlarges any face of any part that you select. After you have 

started the command, you can move your screen pointer over any part of an assembly 

or any face of a part. As you do so, you’ll also notice yellow or green dots appear as you 

move over points. If you select one of the points, the view will not enlarge but will center 

on the selected point.

The next tool is the Free Orbit tool (commonly referred to simply as the Orbit tool). 

Until the introduction of the ViewCube (see the ViewCube section later in this chapter), 

it was the primary way users could quickly rotate a model to view it from other direc-

tions. It is valuable to learn about this tool, but I expect most new users to become as 

dependent on the ViewCube as I have in the short time that I’ve been using it.

When the Orbit tool is running, a circle with four rays will appear. This is known as 

the Reticle. The horizontal and vertical lines represent the X and Y axes of the screen. As 

you near them, the cursor changes to an arrow in a loop. Clicking and dragging at that 

time rotates the object about the axis of the screen. When you move your mouse outside 

the circle but away from the axes, the cursor changes to an arrow in a circle. Clicking 

and dragging at that time causes the model to rotate about the Z axis of the screen. If you 
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Navigating Inventor’s User Interface  ■   13

move away from the center of the screen, you see yet another cursor: this one takes the 

shape of the arrow on an Enter key. Clicking with this arrow displayed is a shortcut out  

of the Orbit tool.

Now move the cursor inside the circle, where it will look similar to the toolbar button 

you selected in the first place. Clicking and dragging inside the Reticle causes the model to 

tumble about the center point of the screen. You can change what portion of the model is 

centered on the screen by hovering over a point and double-clicking the primary mouse 

button. This causes the model to shift position similar to clicking a point using the Zoom 

Selected tool.

The Constrained Orbit tool is basically the same as Free Orbit but designed to pivot 

around the axes of the model.

After the ViewCube (discussed next), the Look At tool is the one that I use the most. 

Once you’ve selected the tool, it highlights planar faces and edges as you move your cur-

sor over the model. If you select an edge, it rotates the view of the model so that the edge 

that you selected is centered and horizontal. If you select a face, it rotates the view so that 

you are looking directly at the face, and it centers the face in the view as well. This is a 

great tool to get yourself reoriented if you become confused about what you are looking 

at. You can also access the tool through the Home key.

The next two items are toggles to control the visibility of the ViewCube and the Steer-

ing Wheels, so I’ll briefly explain those important features.

The ViewCube
When you click the ViewCube toolbar button, the ViewCube appears in the upper-right 

corner of the Design window. The ViewCube allows you to click the named faces of the 

cube and have the part orient itself to match the cube’s new orientation. You can also 

rotate the part about its center by clicking the cube and dragging it while holding down 

the mouse button. Other features include the ability to select corners and edges of the 

cube to rotate the part. There are also two curved arrows that appear when you’re look-

ing directly at a standard view. These arrows allow you to spin the part about the axis of 

the screen. It is the same effect as if you pressed a finger into the center of a piece of paper 

and rotated the sheet under your finger. As you near the ViewCube, another icon appears 

in the upper left; it looks like a house. Clicking this returns 

your model to the Home view. You can also return to the 

Home view at any time by pressing the F6 key. You’ll work 

with the ViewCube throughout this book.

The Steering Wheels
The Steering Wheels (plural because there are a few different versions) allow “heads up” 

access to the Zoom, Orbit, and Pan tools as well as several other features. The ViewCube 
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14  ■   Chapter 1 : Inventor Face to Face

and Steering Wheels can be found not only in Inventor but other Autodesk products as 

well, such as AutoCAD. Because of this, some of the tools on the Steering Wheels are 

not specifically built for Inventor. Walk, Look, and Up/Down may be useful for showing 

someone how to navigate through a large assembly, but I suspect that other tools will be 

more useful to you.

The Rewind Tool
The Rewind tool (Figure 1.10) is particularly valuable. As I mentioned earlier, the Undo 

function does not record or effect changes to Zoom. Rewind shows you a “film reel”–

style list of previous views, and as you move through them you see the model move back 

to previous points of view. This is a double benefit because the “film reel” allows you to 

move quickly to an approximate view that you want to recall, but the onscreen display 

gives you the full view immediately so you can be sure you are getting what you want. In 

case you’re wondering, there’s also a keystroke that can recall previous views, but it does 

not offer the “film reel” view. Pressing the F5 key recalls the previous view. If you press 

F5 again, it goes back again. Holding the F5 key automatically cycles back through previ-

ous views until you release it.

Display Options
The last four icons on the Inventor Standard toolbar deal strictly with the appearance  

of the model.

The first f lyout button allows the 3D model to be displayed as a Shaded Display,  

Hidden Edge Display, or Wireframe Display. Figure 1.11 illustrates the three modes.

Figure 1.10

The Rewind tool
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The next flyout button controls whether the model will be viewed in Perspective. You 

can even alter the lens length of the perspective view to give a different effect. Do this by 

selecting the Zoom command and then holding the Alt and Shift keys at the same time. 

This changes the apparent focal length of the perspective view “lens.” Holding the Alt key 

and pressing the Shift key while rolling a mouse wheel also works.

As you can see in Figure 1.12, displaying a shadow of the model can sometimes help 

you keep your orientation. The display of the two types of shadow is controlled by the 

flyout to the right of the Perspective button. Ground Shadow casts a shadow of the overall 

shape of the part or assembly as though there were a light above it, and X-Ray Ground 

Shadow shows more of the internal characteristics of a part and casts individual shadows 

for the parts of an assembly.

Figure 1.11

3D display modes. 
Shaded Display 
(left) is the most 
realistic; Hidden 
Edge Display (right) 
shows the edges 
on the back of the 
shaded model; and 
Wireframe Display 
(bottom) allows you 
to see all of a part’s 
features.
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16  ■   Chapter 1 : Inventor Face to Face

The final button is only available in the assembly. It is a f lyout that controls whether 

other parts of an assembly dim or become transparent when you activate a part in the 

assembly to edit it. It is not available to Inventor LT users.

If Component Opacity is left on (the default), only the part being edited in the context 

of an assembly will be of a solid color. All of the other parts will change in some way. I 

highly recommend working in this way as it helps you to keep track of whether you are in 

the assembly or are editing a part in the assembly.

To demonstrate this, hover over the muffler (Tuned Pipe) of the assembly and notice 

that it highlights. Once it has become highlighted, double-click it quickly. After it has 

been made “active,” your display should look something like Figure 1.13.

Figure 1.12

Displaying  
a shadow can  
help maintain  

perspective.

Figure 1.13

Using the Compo-
nent Opacity option
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Additional buttons and flyouts appear on the Inventor Standard toolbar (usually 

at the right end of the toolbar) as you work with different files. Like the tools that you 

just reviewed, these additional tools provide some great options and additional capabili-

ties. We’ll cover these in future exercises so that you learn each one in its most relevant 

context.

The Panel Bars
The vast majority of the tools that you use day to day with Inventor can be found in the 

Panel bars. By default the Panel bars are located in the upper left of the display and dis-

play their tools with an icon and descriptive text.

Panel bars can be thought of as smart toolbars. I prefer to think of them as toolbars 

that are “contextual.” They understand what tools are needed based on whether you are 

sketching 2D elements, putting 3D features on a part, or creating drawings. They adjust 

to provide you with these tools automatically. There are two major benefits to this. First, 

you don’t need to have screen space occupied by toolbars that are not relevant to what you 

are doing. For example, why have a dimension tool taking up screen space when you are 

attaching parts to one another in an assembly? Second, it provides feedback about what 

Inventor thinks you’re trying to do. For example, suppose I am in a part model and make 

an errant mouse click, thinking that I have asked to create a new sketch. If the sketch 

tools do not automatically appear, I can instantly recognize that I must have made a mis-

take in my request.

The Browser Bar
In the default display, the Browser bar is positioned directly below the Panel bar. The 

Browser bar displays a list of features or relationships that reflect how the file that you are 

working in was built. Regardless of the type of Inventor file, critical information on how 

it was constructed can be easily reviewed. This is particularly important when you are 

working on a file that you did not create or last edit.

As you create and edit 3D and 2D files in later chapters, you will do quite a bit of work 

with the Browser, and you’ll see some capabilities that any user can take advantage of.

The Design Window
The Design window is where the file that you’re editing is displayed. Along with the dis-

play of drawings and geometry, this window has a couple of special elements worth not-

ing that appear by default. The 3D indicator shows what orientation the part or assembly 

file has to the X, Y, and Z axes. For the sake of clarity, the X axis is red, the Y axis is green, 

and the Z axis is blue. Although it is not always critical to orient parts in a particular 

direction, doing so can be useful for understanding how a part is constructed and for 

sketching a horizontal or vertical relationship between points.
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The Status Bar
The final major screen element that I’d like to review before you begin working in Inven-

tor is the status bar. This term refers to the display along the bottom edge of the Inventor 

window. It has multiple functions, but most of them are for delivering information.

If you’re an AutoCAD user, you probably noticed that there is no “command line” in Inven-

tor. However, when you’re in a command if you become unsure of what is expected, you can 

look at the lower-left corner of the Inventor window and on the status bar will be a prompt 

describing what is expected of you.

While you are creating geometry, the right side of the status bar displays feedback 

on that geometry. For example, while you’re drawing a line, the status bar tells you the 

position of your endpoint, along with the line’s length and direction. This helps you to 

approximate the size of the geometry you’re creating.

The status bar has a couple of other important capabilities. At the far right you’ll find 

two numbers and a rectangular black box that may have one or more portions colored in. 

The first of the two numbers represents Total Occurrences In Active Document, which 

is the number of parts being shown on screen. The second number represents the Open 

Documents In Session, which is the number of files being accessed by Inventor. 

For example, an assembly that has five copies of one part file in it may display the 

numbers 5 and 2 because you are displaying five components on screen that reside in  

two files—one part file and an assembly file. The Engine MkII.iam that you have loaded 

shows that there are 83 total occurrences and 54 active files in Inventor. The bar repre-

sents the amount of memory that Inventor is using. On 32-bit operating systems (Windows 

XP, Windows 2000), the bar starts out green, and as memory consumption increases, it 

changes to yellow and eventually red. On 64-bit systems (Windows XP 64, Vista 64-bit), 

a second bar shows the total system consumption of RAM. On my system I was happy 

to see how little RAM Inventor was using but alarmed to see how little was left by other 

programs running.

The last item in the status bar looks like a satellite dish. This is your Communication 

Center. You can use the Communication Center to look for updates periodically to the 

software. You can establish other settings, such as alerts for online tutorials or even noti-

fications of when a new hot fix or service pack is available. This is another functionality 

shared with many Autodesk applications.
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Make Yourself at Home: Customizing Inventor
Now that you have a basic feel for some of the tools that you will use most frequently, 

it’s time for you to make yourself at home. You’ve already seen examples of customizing 

Inventor in some of the previous images, where you may have noticed that the background 

of the Design window changed colors. I made this change for clarity in the printed images; 

you can also make changes to tailor Inventor to your needs. Inventor can be customized 

at several levels. In this section, I’ll detail a few of the options and even show you how to 

save the way you’ve configured Inventor for future use.

Changing coloring of Inventor’s work environment and sketching elements can make 

it easy to see what you’re working on. Some users like to reposition or resize the tools to 

give themselves more room to work or to make the tools easier to find. Most of these set-

tings you will experiment with once or twice, but once you are comfortable you may not 

want to change them again.

Some of the options in these exercises are unique to assemblies and drawings of 

assemblies, so they will not appear in Inventor LT.

Application Options
Let’s start with the Application 

Options dialog box (Figure 1.14). 

This is the central repository for 

your personal settings. These are 

the settings that control how Inven-

tor looks to you and what options 

you want to use. These tools do 

not affect settings that are local to 

models and drawings. To access the 

Application Options dialog box, 

choose Tools ➔ Application Options.

Figure 1.14

The Application 
Options dialog box, 
with the General tab 
displayed
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Notice the Import and Export buttons at the bottom of the window. These two tools 

allow you to save the settings that you prefer or even transfer them to other users or other 

systems where you will be using Inventor. Your settings are saved as XML files.

The AutoCAD_Related_Options.xml file will change the help system to AutoCAD-related 

settings, reverse mouse wheel zoom direction, and change the background to black. If 

you installed Inventor with AutoCAD preferences, you may have some of the same set-

tings already active. The Inventor_Default_Options.xml file restores Inventor’s default 

settings.

As with other dialog boxes, there is a Help button in the lower left with specific help 

for the tool you are working with. Clicking Help lists the specific portions of the tab that 

you have active.

Let’s walk through the dialog box tab by tab. We won’t cover absolutely everything, 

but there are some items that can make major changes to Inventor’s look, feel, and behav-

ior. There will be some items not covered at this time that I’ll discuss when they become 

more relevant later on in the book.

Each tab has several subsections that have a border around groups of check boxes, 

radio buttons, and pull-downs lists. Each section has a header that makes it easy to figure 

out what all of those devices will affect. The following comments will be organized by tab 

and subsection to make navigation as painless as possible.

The General Tab
Tools on the General tab (see Figure 1.14) tell Inventor how you want the program to 

start, what name you want recorded as the author for files that you create, and other 

basics.

Start-up  ​The Show Help Focused On option may be useful if you’re an experienced Auto-

CAD user; you may want to consider switching the focus of the help system to the one for 

AutoCAD users.

Start-up Action  ​The Open dialog box allows you to switch to the New dialog box, but in 

this section you can change whether Inventor starts with Open or New. You can also have 

Inventor begin a new file based on a specific template, or by deselecting the check box at 

the top of the section, you can have Inventor just open without creating or editing a file.

ToolTip Appearance  ​This is an interesting set of options. The first option will allow the 

“in command” tips that normally appear on the status bar to appear near your cursor 

to guide you through command options. This can be a great option particularly for new 

users to get additional help in a more “heads up” fashion.

Selection  ​The Enable Optimized Selection option may be useful if you’re using Inventor 

on a system with limited graphics performance. It sets the selection and highlighting to 

initially only highlight the parts that are closest to the front in the display.
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The Colors Tab
To change the overall look of Inventor, the Colors tab (see Figure 1.15) has the tools for 

the job. Many users simply change the color scheme, but there are several other options 

that can be useful.

Color Scheme  ​Inventor has several standard color schemes that control the color of the 

graphics window background, highlighted elements, and sketch elements.

Background  ​Inventor can use a single color, a gradient of colors, or any standard raster 

image as a background for the graphics window. It comes with a library already installed.

Reflection Environment  ​Inventor comes with several image files that surround the model 

you’re working on, so that if you have reflective colors on parts such as chrome, you will 

see this image “reflected” on those parts.

The Display Tab
This is the tab for Inventor Suite 2009 users where they can do the most tailoring of how 

Inventor will respond to specific actions. Looking at Figure 1.16, you can see just how many 

options there are, and many of them can have a noticeable effect on how Inventor looks.

Figure 1.15

The Colors tab in the 
Application Options 
dialog box
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Wireframe display mode  ​When you’re in Wireframe mode, choosing Active ➔ Dim Hid-

den Edges enables the model edges in the background to appear darker than edges in the 

foreground. The amount of dimming is controlled by the % Hidden Line Dimming value 

near the bottom of the Display tab.

Shaded display modes  ​There are a lot of interesting ways to work with these options. 

Experiment—you can’t hurt anything. In an exercise later in this chapter, you will change 

a couple of the settings and see an effect in which rather than parts fading when you acti-

vate a single component, the parts that you are not editing will go to wireframe display.

Enabled  ​Confusingly, this setting affects the display of parts that will be inactive in the 

assembly when you’ve activated another part. For example, when you double-clicked 

on the muffler earlier in the chapter, you activated that part. The other parts appeared 

dimmed but still shaded. If you had Shaded deselected in this tab, those inactive parts 

would have appeared as wireframe.

Display quality  ​When there is limited graphic or system memory capacity, Inventor  

may degrade the quality of the model image while rotating or zooming. These settings 

Figure 1.16

The Display tab in 
the Application 

Options dialog box
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will affect how quickly Inventor begins to degrade the display quality. If you have a high-

performance system, you may want to click the Smooth setting to keep rounded edges 

and faces smoother longer.

Show hidden model edges as solid  ​Deselecting this checkbox changes the display of hid-

den edges in the wireframe view from solid lines to hidden lines.

3D Navigation  ​The Reverse Direction option under Zoom Behavior controls the direc-

tion of the wheel button zoom. This option was added for AutoCAD users who prefer the 

effect of moving the camera as mentioned earlier.

The Hardware Tab
If you are using Windows 2000 or XP, you can use this tab to select whether the graphics 

engine in Inventor will be based on OpenGL or Direct3D. Vista users will see that there is 

no OpenGL option.

Notice the Use Software Graphics option. If you experience frequent crashes, try run-

ning with this setting for a while. Your performance will be greatly limited, but if you 

find that your system is more stable that way, it means you need to find an approved 

driver for your graphics card or update your graphic hardware. You can find more infor-

mation on graphics drivers under the Help flyout menu under the heading Additional 

Resources.

The Drawing Tab
Notable here is the Default Drawing File Type option. Beginning with Inventor 2008, you 

can create your 2D drawings as native DWG files, which are compatible with AutoCAD. 

The original IDW file format of Autodesk Inventor is still a valid and reliable file, but the 

strength of having fully native 2D data that can be shared with AutoCAD is very useful.

The Sketch Tab
Figure 1.17 shows the Sketch tab. The settings on this tab tend to be personal. Just the 

Display group with its grids and axes are often set differently from user to user in a com-

pany, which is why the options are available.

Overconstrained dimensions  ​When we discuss applying dimensions and constraints to 

sketches in Chapter 3, you will learn that Inventor will not allow a sketch to be “over-

constrained.” Constraining a sketch means that you apply controls to the movement 

of points in a sketch and to the size of a sketch. When Inventor detects a redundant or 

unnecessary constraint, this option defines whether Inventor automatically places a  

“reference” dimension or prompts you for what to do.
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Display  ​When beginning a new sketch, you may or may not want to see a grid. Some 

users feel the grid helps them keep the proportions of the sketch more accurately. Minor 

gridlines are smaller gridlines that appear between the primary ones. The axes are thicker 

lines that cross through the center of the sketch on the X and Y axis.

Edit dimension when created  ​Selecting this checkbox causes Inventor to prompt you 

for the value of a dimension as soon as it is placed it in a sketch. This can be helpful for 

remembering to apply the values for the dimension as you place them.

Autoproject edges for sketch creation and edit  ​When you create a new sketch on a part or 

assembly face with this option selected, the edges that are coplanar with that sketch are 

copied into the sketch. This can be handy for locating new features, but I find that many 

of these projected edges aren’t used as a reference and can also cause errors downstream. 

Autodesk has improved the robustness of this feature, but it is an option that I often 

remove.

Look at sketch plane on sketch creation  ​When you create a new sketch on a face in an 

isometric view of a part, Inventor’s default is not to change your view orientation. With 

this option selected, the display will behave like the Look At zooming tool and bring your 

focus perpendicular to your new sketching plane.

Figure 1.17

The Sketch tab in 
the Application 

Options dialog box
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Autoproject part origin on sketch create  ​This option will cause Inventor to project the 

location of the “zero” or “origin” of the part into every new sketch. Having this geometry 

projected does not mean that you have to use the geometry or constrain geometry to it.

The Part Tab
The option you may want to customize here is Sketch On New Part Creation. This allows 

you to choose what your “default” sketching plane is. It is a purely subjective preference, 

but many people find that they think about parts they are designing in either a profile or 

an overhead view. This option allows you to choose how a part is oriented when it is first 

created.

The Assembly Tab
The noteworthy option here is Constraint Audio Notification. By default, when a con-

straint is placed in Inventor, the sound of a cowbell is played. When you’re starting out, 

this is a handy feature for confirming that a constraint was placed. After you hear the 

cowbell a couple of hundred times per day, you can come here to disable the audio cue.

Creating a New Work Environment
I know that some of this can be hard to digest, so let’s do some hands-on work. Let’s cre-

ate a new work environment. We will keep the changes limited to the visual elements for 

now. After you are finished, you can make other changes at any time.

Some steps will not be applicable to Inventor LT users.

	 1.	 If you still have Tuned Pipe (muffler) active from the previous action, you are all 

set. If not, double-click on the muffler in the Design window to activate it. Another 

alternative is to double-click Tuned Pipe in the Browser or to right-click Tuned Pipe 

and select Edit.

	 2.	 Open the Application Options dialog box by selecting Tools ➔ Application Options.

	 3.	 Select the Colors tab.

	 4.	 Under Color Scheme, choose Wonderland and watch the preview change at the top. 

Note that most of the elements of the screen change. Click the Apply button in the 

lower right, and you will see the change take effect on the Design window in the 

background.

	 5.	 In the upper left of the preview pane are Design and Drafting buttons that show the 

effect of the color scheme in the 3D and 2D environments. Click the Drafting button 

and then click the Design button.

	 6.	 In the Background area, change the style from 1 Color to Gradient and note the 

effect.

	 7.	 Select the Presentation Color scheme and click Apply.
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	 8.	 Now change the Background option to a Background Image. Although there is a file 

that is the default for each color scheme, after you make this change you can select 

any BMP, JPG, PNG, GIF, or TIF for use as a background. After switching to the 

Background Image, click Apply again to see the effect.

	 9.	 Switch the Background option back to Gradient. A Gradient background will offer 

better performance than a Background image for lower-powered systems.

For clarity in print, screen images captured for this book are created with the Presentation 

Color scheme and the 1 Color option. This is a great setup if you need to create printable 

images from your models.

	10.	 Switch to the Display tab.

	11.	 Under the Wireframe display mode, select Dim Hidden Edges under the Active 

group.

	12.	 Under Shaded display modes in the Enabled group, deselect Shaded and select  

Silhouettes.

	13.	 Under Shaded Display Modes in the Active group, deselect Edges and select  

Silhouettes.

	14.	 Update your display by clicking Apply. Tuned Pipe should be the only shaded  

component on the screen.

	15.	 In the Display tab, deselect the Show Hidden Model Edges As Solid option.

	16.	 Now let’s save it all. Click the Export button at the bottom of the dialog box. The 

Export dialog box opens to the default location for the profile, but you can save  

your settings to any location. Name your file Test settings.xml.

	17.	 Your screen should look something like Figure 1.18.

	18.	 Click the Return button to return to the assembly environment.

You’ve done it. You’ve made Inventor look and behave differently than it did when it 

was installed. For your own use you may choose different settings, but it is critical that 

you are comfortable with making changes to Inventor so that it suits you and the inter-

face is not a distraction from working. There are a few more changes that can be made  

to suit your needs.

The Panel bar displays both the icon and the name of tools that it contains. As you 

become more comfortable with Inventor, you may want to display only the icons. Keep in 

mind that a tooltip will still be displayed if you hold your cursor over an icon even if you 

no longer display the command name.
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You can change your Panel bar to no longer display the com-

mand name. To do this, right-click in an open part of the Panel 

bar or click the flyout arrow next to Assembly Panel and deselect 

the checkmark next to Display Text with Icons. 

When you do this, the scrollbar (which was previously necessary to view all the com-

mands) disappears because all the commands now fit in a small area. Many users prefer 

this as a way to maximize screen space and avoid having to scroll to find some tools. I 

want to stress that I do not recommend working with icons only while you are beginning 

to use Inventor.

Depending on the version of Windows that you’re using, you may see two horizontal 

bars at the top of the Browser and at the top of the Panel bar. If you click and drag on 

this area, you can move the components around, or “undock” them from the side of the 

Inventor window so that they are “floating.” Once you are comfortable enough to work 

with only the icons, you can dock the Panel bar next to the Browser and then narrow  

the Panel bar to show one vertical column of icons. The result looks something like  

Figure 1.19.

Figure 1.18

The Inventor display 
is flexible and can 
be modified to suit 
your taste.
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At this point, if you’ve changed your interface it may be best to put the Panel bar and 

Browser back in their default location.

One last thing that you need to know about the Panel bar, the Browser, and the Inventor 

Standard toolbar is that their display can be turned off if you want to show your model in 

a maximum screen mode. You can do this from the menu bar: choose View ➔ Toolbar and 

deselect any of the tools that you do not want displayed. You can use the same method to 

reselect them if they somehow get turned off.

Project Files
Inventor is normally a breeze to work with. There are only a handful of ways to make it 

difficult. One common bad habit is not properly controlling where files are kept. Inventor 

keeps track of where things are supposed to be using a project file.

As an old friend of mine so perfectly put it: “A project file is a text file that tells Inven-

tor where to put stuff ”—and that’s all there is to it. The project file allows you to control 

where Inventor looks for templates, what styles are available, and where Inventor stores 

files, including standard parts like bolts. This opens up a lot of possibilities, such as using 

different project files to switch templates with different title blocks when you work on 

jobs for multiple customers. Over time, more and more Inventor users establish one proj-

ect file and sort jobs as folders under that project file. In an earlier example, in the Open 

Figure 1.19

Alternate Panel 
bar and Browser 

arrangement
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File dialog box you used the Frequently Used Subfolders list to find the assembly of the 

engine. The Samples.ipj project file that you selected is a great example of a project file 

that is used to organize many different datasets with many different types of design.  

Figure 1.20 shows what Samples.ipj looks like if you open it in the Project File editor.

The Project File editor is a fairly simple tool. It has a list of project files that have been 

used at the top in the Select Project pane, a display of the paths and properties of the 

highlighted project file in the bottom in the Edit Project pane, and a handful of tools on 

the right for modifying the project file. There are a few rules for project files:

You cannot change the active project file when a file is open.•	

You cannot add a Frequently Used Subfolders shortcut to a folder that is not “under” •	

the location of the project file.

To edit a project file, you must have read/write access to the file or folder that it is in.•	

As you select different options, buttons on the right change to show that they are avail-

able or unavailable. As you read through the descriptions of what the sections of the proj-

ect file do, try selecting them and note which buttons become available. As you explore, 

continue to use the Samples.ipj project file that you made active previously. Here are 

some of the elements of the project file:

Type  ​You will work with two primary types of project file. The Type option allows you to 

select between them:

Single User  ​For the stand-alone user who will not be sharing data with other users 

simultaneously.

Vault  ​Only available if you have installed the Vault, Autodesk’s file management tool 

that comes with Inventor. It enables simultaneous sharing with multiple users.

Figure 1.20

The Project File 
editor
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Two other types of Project file allow multiple users to access data, but I cannot recommend 

strongly enough that you use the Vault if you intend to share data in a network environment. 

The Vault is free and provides additional tools to make your work easier.

Location  ​This setting tells Inventor where the file is installed and also establishes a “rela-

tive path” that the other search paths will use to shorten their own searches for files. 

The project file may be in C:\Users\Public\Documents\Autodesk\Inventor 2009\Samples\ 

but in its search Inventor will skip all of the previous directories and begin searching for 

files under the \Samples folder. This may not seem important, but it can greatly improve 

performance.

Use Style Library  ​Only users with the proper permissions can control the value of this set-

ting. This setting controls whether a user can edit, use, or even access style libraries (see 

Chapter 5).

Libraries  ​In addition to the Content Center libraries that ship with Autodesk Inventor, 

users can declare that files in specific folders be treated as library files. These files can-

not be edited while you are using a project file that defines them as a library. It’s also 

important that you not allow these files to be edited by people who don’t consider them 

a library.

Frequently Used Subfolders  ​As you saw earlier in this chapter, you can define shortcuts 

that take you to folders that are relevant to the work you need to get done. Creating a  

path to a folder and another path to another folder under it replicates the structure on  

the disk. These shortcuts can be given any name, and you should name them in a way 

that is clear to you. For example, a disk path of C:\Data\Components\support structure 

components could have a shortcut of Brackets.

Folder Options  ​This area allows you to establish paths to styles and templates that are in 

locations other than the ones that Inventor uses when it is installed. This is important in 

a network environment where you may want to have everyone accessing the same tem-

plates from a central source. The Content Center Files path tells Inventor where to put the 

“local” copies of standard content used by the files that you’ll be working with. This too 

is an important consideration for a network environment so that you don’t, for example, 

have multiple people keeping individual copies of the same standard bolt on their own 

computers.

Options  ​The group contains a couple of interesting items, but most of them are less 

frequently modified than other parts of the project file. The Old Versions To Keep On 

Save value controls the number of versions of the file that will be saved to an Oldversions 

directory in the file path. These older files can be restored as a new file or over the cur-

rent version of the file. It’s important to note that if you restore over the current version, 

all changes made since the old version was saved will be lost.
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Project File Manager Buttons
The buttons on the right side of the editor not only help you edit the file but also, by being 

available or being grayed out, offer visual cues for whether you can make certain changes.

The arrow buttons are available where there are lists of folders that you may want to 

sort for priority or convenience.

The Add button appears when you have selected a category where a path or other 

information can be added.

Edit will be active when a value can be edited.

Clicking this button expands options for the project workspace or for establishing a 

workgroup. Note that workgroups are not used with single-user or Vault-oriented project 

files. When this (and any other) dialog is expanded, the arrows point to the left to show 

that the dialog can also be collapsed.

Clicking this button generates a list of duplicate files in the project. You can use the 

list to compare files and choose how to treat them. If two unique parts have the same 

name, you can modify one of them to avoid confusion downstream. If there are two 

instances of an identical file, you should remove one of them and allow Inventor to seek 

out the remaining instance so there is no risk of having the incorrect version of a part in 

the assembly.

The Content Center can have many types of standard content (nuts, bolts, etc.), and 

you may not use all of them in a project. This button allows you to limit the standards 

that are used by the project itself.

Creating a Project File
Now that you have a basic overview of the project file, it is time to make one of your own 

that you will use for future exercises.

	 1.	 Close any files that you have open in Inventor. Don’t save changes to the Engine MkII.

iam file if you are prompted to do so.

	 2.	 On the main menu, choose File ➔ Projects.

	 3.	 Click the New button at the bottom of the dialog box. This will open a Wizard that 

will help you step through creating a new Project file.

If you have Autodesk Vault installed, you have the option to choose to create a new 

Vault project or a new single-user project, as shown in Figure 1.21. If you do not have 

the Vault installed, you will not be offered the Vault project option.

	 4.	 Select the radio button next to New Single User Project and click the Next button at 

the bottom.

The Oldversions directory can hold multiple versions of a file, created each time the file is 

saved. It’s like having multiple BAK files that can be restored.
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On the next screen, you can name the file and set up its location. Keep in mind that 

you are not only establishing the location of a file but also establishing the root folder 

for the models that you will be creating.

	 5.	 Start by typing Introducing Inventor in the Name text box.

	 6.	 On the next line, the default path that Inventor uses will be listed. Click the ellipsis 

icon to the right to begin browsing to a different folder. Figure 1.22 shows the Browse 

For Folder dialog box. In this case we want to create a new folder. Do not create the 

folder in the location initially offered. Instead, scroll to your C drive, select the root 

of the C drive, and click the Make New Folder button. This creates a new folder on 

the C drive and allow you to rename it. Name the new folder Data, and click OK to 

close the Browse For Folder dialog box.

	 7.	 When you return to the Inventor Project Wizard, you should see the path C:\Data 

under Project (Workspace) Folder and a text string showing C:\Data\Introducing 

Inventor.ipj under Project File To Be Created (Figure 1.23).

Figure 1.22

Creating a new folder 

Figure 1.23

The new project name and path

Figure 1.21

Defining the type  
of new project
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	 8.	 Click Finish.

	 9.	 When you return to the Projects dialog box (Figure 1.24), your new project file will 

not automatically become the active project file. Do not change the active project file 

at this time. When you do wish to make you new project active, you must highlight it 

and click the Apply button or double-click on the filename in the Select Project pane.

	10.	 You will see that the Frequently Used Subfolders line is dimmed. This is because no 

shortcuts are currently listed. In some cases you will add a new shortcut that leads to 

an existing path. We will create a shortcut and the path it leads to in one sequence.

	11.	 Select the Frequently Used Subfolders line in the Edit Project pane. When you do so, 

you the Add button becomes available. Click that button and two boxes appear. The 

first is for the name of the shortcut that you want to add; the second is for the path. 

Next to the Path button is a folder search icon that you can click to select an existing 

folder or create a new one.

	12.	 Change the Shortcut name to Parts.

	13.	 In our case we are adding a new folder to the path, so we can just simply add a Parts 

folder after Data in the path and press Enter. 

	14.	 You can click the folder search icon and a file dialog box will appear, Choose Or Add 

A Path For The Project File, appears with one important difference. Clicking the 

Make New Folder button automatically creates a new folder under the workspace 

folder you defined when you created the new project file. Inventor should create a 

new folder and highlight the name for renaming. If Inventor does not offer you a 

chance to rename the folder to Parts, you can do so using Windows Explorer.

	15.	 After you have added this new path, save the change by clicking the Save button at 

the bottom of the dialog box.

Figure 1.24

Introducing Inven-
tor added to the list 
of project files
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Defining a project file is not a difficult process, but it is an important one. It is a good 

idea to decide how you want to share data with others and review how you currently sort 

your design data to help define how your project file should be arranged. It is possible to 

change your file structure after the fact if necessary, and Inventor is able to help you find 

the files it needs—but it is worth some extra time to think about how you want to sort 

your data.

Inventor must know where files are to work effectively. Failing to control your file 

locations can inhibit the program’s performance—and having to tell Inventor where to 

find files will cause you undue stress.

Using the Help System
While any software can be improved, I find the Help system in Inventor to be very good. 

It even comes in different flavors. There is the help that is oriented toward existing Inven-

tor users and those who have used other 3D design programs, or if you are an experi-

enced AutoCAD user, you can have the help system compare Inventor to AutoCAD to 

help you relate a little more easily. Regardless of how you use it, I encourage you to take 

advantage of the Help system as an additional resource.

To access the primary Help system, from the main menu select the icon with the ques-

tion mark, or click Help ➔ Help Topics. Alternatively, you can press the F1 key as in most 

Windows-compatible programs. In the resulting Help window (Figure 1.25), you can 

access the contents, which will show categorized help topics in a book- and chapter-like 

format. Index narrows topic titles as you type a keyword. Search looks through the titles 

and contents of help topics.

Next to the Help icon on the main menu is the icon for the Visual Syllabus. The Visual 

Syllabus (Figure 1.26) is a direct access to the Show Me Animations portion of the Help 

system. This is a collection of animations that show how to use various tools and perform 

tasks. These animations can be used as a way to introduce yourself to new topics or 

refresh your memory on items that you don’t use frequently.

The final icon is Recover, which will normally appear gray. When it is red, this indi-

cates an error that Inventor’s Design Doctor wants to assist you with.

The Design Doctor (Figure 1.27) lists any errors and allows you to select which one 

you want to fix first in the Select screen. On the Examine screen, it offers a solution, and 

the Treat screen allows you to select what treatment method you want to use.

Another important thing to know about the Design Doctor is that you do not have 

to respond immediately. You can do most things in Inventor while there is a problem 

unresolved. In fact, you may do something that you know will cause a problem, and when 

you’re finished, the problem will resolve itself. This is the kind of flexibility that has made 

Inventor popular.
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Figure 1.25

The primary Help window

Figure 1.26

The Visual Syllabus

Figure 1.27

The Design Doctor
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Summary
Inventor’s user interface is as f lexible as it is simple. Learning where to find tools and 

recognizing what Inventor’s tools are asking of you are the first steps. Making yourself 

comfortable allows you to be more efficient with Inventor and makes the overall experi-

ence more enjoyable.

The Inventor development team has put a lot of work into trying to make tools con-

sistent. As we go forward, many of the fundamentals that you’ve learned in this chapter 

will be reused every step of the way. If you are using a tool and it is not offering you 

Open or Apply, take a look for any red arrows or scan the status bar to see what Inven-

tor is looking for.

Finally, never be afraid to ask Inventor for help. The Help system is a great resource 

that is often overlooked.
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